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เรียนรู้โปรแกรม Adobe Photoshop CS6 

 ผลการประเมินโครงการสื่อการเรียนรู้ เรื่อง การออกแบบป้ายโฆษณาโดยใช้
โปรแกรม Adobe Photoshop CS6 โดยภาพรวมอยู่ในระดับมาก มีค่าเฉลี่ย  4.27 และเม่ือพิจารณา
รายข้อพบว่า ผลการประเมินอยู่ในระดับมากเรียงล้าดับ ดังนี้   
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ล้าดับที่ 2 ความส้าคัญของโครงการ มีผลประเมินความพึงพอใจอยู่ในระดับ มาก มีค่าเฉลี่ย 
4.4 

ล้าดับที่ 3 การน้าไปใช้ประโยชน์ได้อย่างคุ้มค่า มีผลประเมินความพึงพอใจอยู่ในระดับ มาก 
มีค่าเฉลี่ย 4.3 
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ล้าดับที่ 4 วิธีการด้าเนินงานและผลที่ได้รับ มีผลประเมินความพึงพอใจอยู่ในระดับ มาก มี
ค่าเฉลี่ย  4 

ล้าดับที่ 5 เนื้อหาและความสอดคล้องของโครงการ มีผลประเมินความพึงพอใจอยู่ในระดับ 
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1.ในระหว่างที่ท้าการตกแต่งป้ายโฆษณาโดยใช้โปรแกรม Adobe Photoshop CS6 นั้นควร
ท้าแล้วก็กดเซฟงานบ่อยๆ เพราะบางครั้งอาจเกิดเหตุขัดข้องในการใช้โปรแกรมได้ เช่น คอมพิวเตอร์
ของท่านอาจจะดับระหว่างท้างานอยู่ หรืออาจเกิดจากการที่โปรแกรมไม่ตอบสนองหรือค้างนั่นเอง 
เพราะฉะนั้นเราจึงควรท้าการเซฟชิ้นงานที่ท้าอยู่บ่อยๆ เพ่ือที่จะได้ไม่ต้องมาเสียเวลาในการเริ่มท้า
ชิ้นงานใหม่ทั้งหมด   

2. รายงานโครงการ 5 บท ควรให้ความส้าคัญกับการจัดรูปแบบให้ถูกต้อง สวยงาม ตาม
รูปแบบหรือโครงสร้างที่ก้าหนดให้ 
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บทท่ี  1 
    บทน า 

 

ความเป็นมาและความส าคัญของปัญหา 
 ในการเรียนการสอนระดับประกาศนียบัตรวิชาชีพช้ันสูงตามหลักสูตรของส านักงาน
คณะกรรมการการอาชีวศึกษาปี 2546 ได้จัดให้มกีารเรียนการสอนวิชาโครงการ รหสัวิชา 3401-
6001 โดยก าหนดให้นกัศึกษาจัดท าโครงการ 5 คน ต่อ 1 โครงการ เพื่อให้นกัศึกษาได้ใช้ความรู้
ความสามารถจากการเรียนในสาขาวิชาของตนมาประยุกต์ใช้ในสร้างสรรค์ผลงานใหเ้กิดประโยชน์ต่อ
การท างานและน าไปใช้ในชีวิตประจ าวันได้ 

จากการศึกษาในสาขาวิชาคอมพิวเตอร์ ได้ศึกษาค้นคว้าการใช้งานของโปรแกรม Adobe 
Photoshop CS6 ซึ่งเป็นโปรแกรมส าหรับตกแต่งภาพถ่ายและภาพกราฟฟิก ส าหรบัคนที่ต้องการ
ตกแต่งภาพ ท าหน้าปกนิตยสาร หรือสร้างภาพ โปรแกรม Adobe Photoshop CS6 หรือจะเรียกว่า 
โปรแกรมตัดต่อรูปภาพหรือตกแต่งรปูก็ได้ มันเป็นโปรแกรมส าหรับตกแตง่รปูภาพและภาพกราฟฟิก
ต่างๆที่ใช้ด้วยงานฟังก์ช่ันที่ครบครัน และถือเป็นโปรแกรมทีไ่ด้มาตรฐานที่สุด ที่ใช้ความหลากหลาย 
สามารถน ามาใช้ในการท างานเกี่ยวกับตกแต่งและแก้ไขรูปภาพ หน้าตาของโปรแกรม Adobe 
Photoshop CS6 ใช้งานได้ง่ายไม่จ าเป็นต้องมีทักษะเกี่ยวกบัคอมพิวเตอร์มากนกั สามารถท างานได้
ราบรื่น โดยใช้เวลาเพียงไม่นาน ในสาขาคอมพิวเตอร์ส าหรบัโปรแกรมนี้ถือว่ามีความส าคัญที่ควร
ศึกษาและเรียนรู้ สามารถสง่ต่อความรู้ให้กับรุ่นน้องๆ ในสาขาได้ และน ามาใช้ในการเรียนการสอน
ปัจจุบัน เพื่อใหผู้้เรียนได้มีความรู้ความเข้าใจเกี่ยวกับโปรแกรม Adobe Photoshop CS6 ซึ่งเป็น
ความรู้เบื้องต้นของการเรียนสาขาคอมพิวเตอร์ธุรกจิ และน าไปปรบัใช้ในชีวิตประจ าวันได้อย่าง
ถูกต้อง  จึงได้สร้างสื่อการเรียนรู้ เรื่อง “การออกแบบป้ายโฆษณาโดยใช้โปรแกรม Adobe 
Photoshop CS6” เพื่อสามาถน าไปเผยแพร่ยังสถานศึกษา ชุมชุมหรือผู้ที่สนใจได้อีกด้วย  

 
วัตถุประสงค์ของโครงการ 

1. เพื่อพัฒนาสื่อการเรียนการสอนในช้ันเรียน และสื่อการเรยีนรู้ในการศึกษาด้วยตนเอง โดย
ใช้โปรแกรม Adobe Photoshop CS6 

2. เพื่อศึกษาความพึงพอใจของผู้ใช้สื่อการเรียนรู้ด้วยโปรแกรม Adobe Photoshop CS6 
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ขอบเขตของการศึกษา 
 1. ขอบเขตในเนื้อหา 
     ศึกษาความพึงพอใจต่อการใช้โปรแกรม Adobe Photoshop CS6 มาใช้ในการท าสื่อ
การเรียนการสอนในวิชาคอมพิวเตอร ์
 2. ประชากรและกลุ่มตัวอย่าง 
     ประชากรที่ใช้ในการศึกษาครั้งนี้ คือ นักเรียนระดบัประกาศนียบัตรวิชาชีพช้ันสูงปทีี่ 2 
สาขาวิชาคอมพิวเตอร์ ภาคเรียนที่ 1 ปีการศึกษา 2560 วิทยาลัยเทคโนโลยีอกัษรบรหิารธุรกจิ อ าเภอ 
บ้านฉาง จังหวัด ระยอง สงักัดส านักงานเขตพื้นที่การศึกษาระยอง เขต 1 จ านวน 70 คน เลือกมาเป็น
กลุ่มตัวอย่างโดยการสุ่มอย่างง่าย (Simple Random Sampling) จ านวน 20 คน   
 3. ด้านวัน เวลาและสถานที่ท าโครงการ   
    การวิจัยครัง้นี้ด าเนินการตั้งแต่วันที่ 31 กรกฏาคม 2560 - 20 กุมภาพันธ์ 2561 ที่
วิทยาลัยเทคโนโลยีอกัษรบรหิารธุรกิจ จงัหวัดระยอง และน าไปทดลองใช้กับกลุ่มตัวอย่าง (ประชากร) 
ระหว่างวันที่ 8 ธันวาคม 2560 - 20 กุมภาพันธ์ 2561 
 
กรอบแนวคิดในการวิจัย 

 
  

 
 

 

 

 

 

 

 

ภาพ 1 แสดงความสัมพันธ์ของตัวแปรที่ศึกษาวิจัย 
 
นิยามศัพท์เฉพาะ   
     ในการศึกษาครั้งนี้ ผู้ศึกษาได้ก าหนดนิยามศัพทเ์ฉพาะไว้ดังนี้ 
  1. สื่อการเรียนรู้ หมายถึง ทกุสิง่ทุกอย่างรอบตัวผูเ้รียนที่ช่วยผู้เรียนเกิดการเรียนรู้ ไม่ว่าจะ
เป็นวัสดุ อุปกรณ์ วิธีการ คน สัตว์ สิ่งของ หรือแนวความคิดที่ถ่ายทอดความรู้ ความเข้าใจ เพิ่ม
ประสบการณ์ หรือเป็นเครือ่งมอืที่กระตุ้นใหเ้กิดการแสวงหาความรู้ด้วยตนเอง 
   2. โปรแกรม Adobe Photoshop CS6 เป็นโปรแกรมในตระกูล Adobe ที่ใช้ส าหรบั
ตกแต่งภาพถ่ายและภาพกราฟฟิก ได้อย่างมปีระสิทธิภาพ ไม่ว่าจะเป็นงานด้านสิง่พิมพ์ นิตยสาร และ
งานด้านมัลติมเีดีย อีกทัง้ยังสามารถ retouching ตกแต่งภาพและการสร้างภาพ 

   

สื่อการเรียนรู้ เรื่อง การตัดต่อ
วิดีโอ โดยใช้โปรแกรม Adobe 

Photoshop CS6 

ตัวแปรอิสระ ตัวแปรตาม 

ความพึงพอใจของนักเรียนทีม่ีต่อสือ่การเรียนรู้ 
เรื่อง การตัดต่อวิดีโอ โดยใช้โปรแกรม Adobe 

Photoshop CS6 
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  3. ความพึงพอใจของนกัเรียน หมายถึง ค่าเฉลี่ยจากการบอกความรู้สึกในการเรียนด้วย
วิดีโอ ชุด การฝึกพูดภาษาอังกฤษ เรื่อง ค าศัพท์และส านวนภาษาอังกฤษที่ใช้ในงานบัญชีจากการตอบ
แบบส ารวจความพึงพอใจที่มีระดับความพึงพอใจ 5 ระดบั คือ ระดับ 1 พึงพอใจน้อยสุด, ระดับ 2 
ความพึงพอใจน้อย, ระดับ 3 ความพึงพอใจปานกลาง, ระดบั 4 ความพึงพอใจมาก และระดบั 5 ความ
พึงพอใจมากทีสุ่ด   
  4. นักเรียน หมายถึง นักเรียนระดบัช้ันประกาศนียบัตรวิชาชีพช้ันสูงปีที่ 2 สาขา
คอมพิวเตอร์ ทีก่ าลงัศึกษาอยู่ในวิทยาลัยเทคโนโลยีอักษรบริหารธุรกจิ อ.บ้านฉาง จ.ระยอง ภาคเรียน
ที่ 1 ปีการศึกษา 2560 
  5. วิทยาลัย หมายถึง วิทยาลัยเทคโนโลยีอักษรบรหิารธุรกจิ ตั้งอยู่ที่ 111/7 ม.3 ต.บ้านฉาง 
อ.บ้านฉาง จ.ระยอง 21130  
 
ประโยชน์ท่ีคาดว่าจะได้รับ 

1. น าสื่อการเรียนรูท้ี่ได้มาใช้ในการเรียนการสอนในช้ันเรียน และใช้ในการศึกษาด้วยตนเอง 
2. ทราบระดับความพึงพอใจของผู้ใช้สือ่การเรียนรู้ด้วยโปรแกรม Adobe Photoshop CS6 

และน าไปปรับปรงุพัฒนาผลงานใหม้ีคุณภาพย่ิงข้ึน 
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บทท่ี 2 
แนวคิด และทฤษฎีท่ีเกี่ยวข้อง 

 

 การจัดท าโครงการครั้งนี้เพื่อเป็นการศึกษาการสร้างสื่อการเรียนรู้ เรื่องการออกแบบป้าย
โฆษณาโดยใช้โปรแกรม Adobe Photoshop CS6 คณะผู้จัดท าได้ศึกษาแนวคิดทฤษฎีที่เกี่ยวข้องไว้
ดังต่อไปนี ้
 

 2.1 ความหมายของโปรแกรม Adobe Photoshop CS6 
 2.2 ส่วนประกอบของโปรแกรม Adobe Photoshop CS6 
 2.3 เครื่องมอืพื้นฐานของโปรแกรม Adobe Photoshop CS6 

2.4 ความสามารถของโปรแกรม Adobe Photoshop CS6 
 2.5 คุณสมบัติของโปรแกรม Adobe Photoshop CS6 
 2.7 ความหมายและความส าคัญของ Layer โปรแกรม Adobe Photoshop CS6 

2.6 ประโยชน์ของโปรแกรม Adobe Photoshop CS6 
2.8 การเปิดพื้นที่การใช้งาน การน าภาพเข้าใช้งาน และการบันทึกงานงาน 

 
ความหมายของโปรแกรม Adobe Photoshop CS6 

โปรแกรม Adobe Photoshop CS6 เป็นโปรแกรมที่มีความสามารถในการออกแบบ
กราฟฟิก เพื่อน าไปใช้ร่วมกบังานในด้านต่างๆ เช่น งานกราฟิกที่เกี่ยวกับสื่อสิง่พิมพ์ทุกประเภท งาน
กราฟิกบนเว็บไซต์และการตกแต่งภาพถ่ายจากกลอ้งดจิิตอลซึ่งอาจกล่าวได้ว่าเป็นโปรแกรมทีม่ีผู้นิยม
น ามาใช้ในการออกแบบและตกแต่งภาพถ่ายกันมากที่สุด โปรแกรม Adobe Photoshop CS6เป็น
โปรแกรมที่ใช้ในการสร้างภาพและ การตกแต่งภาพที่ก าลงัเป็นที่นิยมอย่างสงูสุด ในปัจจบุันเนื่องจาก
เป็นโปรแกรมที่ท างานได้อย่างมีประสิทธิภาพ และผลงานทีไ่ด้เหมาะที่จะใช้กบังานสิง่พิมพ ์นิตยสาร
งานมัลตมิิเดีย และสร้างกราฟฟิกส าหรับเว็บที่นบัวันก าลงัพฒันาไปอย่างไมห่ยุดยั้งและถึงแม้ว่า 
โปรแกรม Adobe Photoshop CS6 จะเป็นโปรแกรมที่มีประสทิธิภาพสูง แต่การใช้งานกลบัไม่
ยาก อย่างที่หลายคนคิด เราสามารถเรียนรู้การใช้งานในโปรแกรม Adobe Photoshop CS6 ได้
อย่างรวดเร็ว แม้ว่าเราจะมีพื้นฐานทางคอมพิวเตอร์ไมม่ากกต็าม ส าหรบัคนที่ต้องการตัดต่อหรอืแก้ไข
รูปภาพ มันเป็นโปรแกรมตัดต่อและแก้ไขรูปภาพต่างๆ ที่มเีครื่องมือการใช้งานด้วยฟังก์ช่ันที่ครบครัน 
และได้มาตรฐานที่สุด หากพูดถึงกระแสความนิยมแล้ว ท างานได้ราบรื่น ไม่กินทรัพยากรเครื่อง ซึง่
เหตผุลเหล่าน้ีจะท าให้คุณใช้โปรแกรมตัดต่อหรือแก้ไขรปูภาพ โดยใช้เวลาเพียงไม่นาน นอกจากนี้
โปรแกรม Adobe Photoshop CS6 ยังเป็นโปรแกรมสร้างและแก้ไขรูปภาพอย่างมืออาชีพ
โดยเฉพาะนักออกแบบในทุกวงการย่อมรูจ้ักโปรแกรมตัวนี้ดี โปรแกรม Adobe Photoshop CS6 
เป็นโปรแกรมที่มีเครื่องมือมากมายเพือ่สนบัสนุนการสร้างงานประเภทสิง่พิมพ์ งานวิดีทัศน์   งาน
น าเสนอ งานมัลติมเีดีย ตลอดจนงานออกแบบและพฒันาเว็บไซต ์ 
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ส่วนประกอบของโปรแกรม Adobe Photoshop CS6 
 เมื่อกดคลิกเข้าสู่โปรแกรม หน้าจอจะแสดงรูปร่างหน้าตาของโปรแกรมขึ้น ในลักษณะ
หน้าตา ดังต่อไปนี ้

1.หน้าแรกเมื่อเข้าสู่โปรแกรม 

 
 

ภาพที่ 1  หน้าแรกเมื่อเข้าสู่โปรแกรม Adobe Photoshop CS6 
 

2. ส่วนประกอบต่างๆ บนหน้าจอเมื่อเข้าสู่โปรแกรม ก่อนการเข้าใช้งาน 

 

 

 
 
 
 
 
 
 
 
 

ภาพที่ 2  ส่วนประกอบต่างๆ บนหน้าจอเมื่อเข้าสู่โปรแกรม ก่อนการเริ่มใช้งาน 
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มีส่วนส าคัญหลักที่ต้องรู้ดงันี ้

1. เมนูของโปรแกรม Application menu หรือ Menu bar ประกอบด้วย 

     1. File หมายถึง รวมค าสั่งที่ใช้จัดการกบัไฟลร์ูปภาพ เช่น สร้างไฟล์ใหม่, เปิด, ปิด, บันทึกไฟล,์ 
น าเข้าไฟล,์ ส่งออกไฟล์ และอื่น ๆ ทีเ่กี่ยวกับไฟล ์

     2. Edit หมายถึง รวมค าสัง่ที่ใช้ส าหรบัแก้ไขภาพ และปรับแต่งการท างานของโปรแกรมเบื้องต้น 
เช่น ก๊อปปี,้ วาง, ยกเลิกค าสั่ง, แก้ไขเครื่องมอื และอื่น ๆ 

     3. Image หมายถึง รวมค าสัง่ที่ใช้ปรับแต่งภาพ เช่น ส,ี แสง, ขนาดของภาพ (image size), 
ขนาดของเอกสาร (canvas), โหมดสีของภาพ, หมุนภาพ และอื่น ๆ 

     4. Layer หมายถึง รวมค าสั่งที่ใช้จัดการกบัเลเยอร์ ทั้งการสร้างเลเยอร,์ แปลงเลเยอร์ และการ
จัดการกบัเลเยอร์ในด้านต่าง ๆ 

     5. select  รวม ค าสั่งเกี่ยวกับการเลือกวัตถุหรือพื้นที่บนรูปภาพ (Selection) เพื่อน าไปใช้งาน
ร่วมกับค าสั่งอื่น ๆ เช่น เลือกเพื่อเปลี่ยนส,ี ลบ หรือใช้เอฟเฟ็กต์ต่าง ๆ กับรูปภาพ 

     6. Filter เป็นค าสั่งการเล่น Effects ต่างๆส าหรบัรปูภาพและวัตถุ 

     7. View เป็นค าสัง่เกี่ยวกบัมมุมองของภาพและวัตถุในลักษณะต่างๆ เช่น การขยายภาพและย่อ
ภาพให้ดูเลก็ 

     8. Window  เป็นส่วนค าสั่งในการเลือกใช้อุปกรณ์เสริมต่างๆทีจ่ าเป็นในการใช้สร้าง Effects 
ต่างๆ 

     9. Help เป็นค าสัง่เพื่อแนะน าเกี่ยวกบัการใช้โปรแกรมฯและจะมีลายละเอียดของโปรแกรมอยู่ใน
นั้น 

2. เมนูของพื้นทีท่ างาน Panel menu 

     Panel (พาเนล) เป็นวินโดว์ย่อย ๆ ที่ใช้เลือกรายละเอียด หรือค าสัง่ควบคุมการท างานต่าง ๆ 
ของโปรแกรม ใน Photoshop มีพาเนลอยู่เป็นจ านวนมาก เช่น พาเนล Color ใช้ส าหรบัเลือกส,ี 
พาเนล Layers ใช้ส าหรบัจัดการกบัเลเยอร์ และพาเนล Info ใช้แสดงค่าสีตรงต าแหน่งที่ช้ีเมาส์ 
รวมถึงขนาด/ต าแหน่งของพื้นที่ทีเ่ลือกไว้ 
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3. พื้นที่ท างาน Stage หรือ Panel 

      เป็นพื้นที่ว่างส าหรับแสดงงานที่ก าลังท าอยู่  

4. เครื่องมอืที่ใช้งาน Tools panel หรอื Tools box 

     Tool Panel (ทูลพาเนล) หรือ กลอ่งเครื่องมือ จะประกอบไปด้วยเครื่องมือต่าง ๆ ที่ใช้ในการวาด 
ตกแต่ง และแก้ไขภาพ เครื่องมือเหล่าน้ีมีจ านวนมาก ดังนั้นจึงมกีารรวมเครือ่งมอืที่ท าหน้าที่คล้าย ๆ 
กันไว้ในปุ่มเดียวกัน โดยจะมีลักษณะรูปสามเหลี่ยมอยูบ่รเิวณมุมด้านล่างดงัภาพ 2 เพื่อบอกให้รู้ว่าใน
ปุ่มนี้ยังมีเครือ่งมอือื่นอยู่ด้วย 

5. สิ่งที่ควบคุมเครื่องมือที่ใช้งาน Tools control menu หรือ Option bar 

      Option Bar (ออปช่ันบาร์) เป็นส่วนที่ใช้ปรบัแต่งค่าการท างานของเครือ่งมอืต่าง ๆ โดย
รายละเอียดในออปช่ันบารจ์ะเปลี่ยนไปตามเครื่องมือทีเ่ราเลือกจากทลูบ็อกซ์ในขณะนั้น เช่น เมื่อเรา
เลือกเครือ่งมอื Brush (พู่กัน) บนออปช่ันบารจ์ะปรากฏออปช่ันที่ใช้ในการก าหนดขนาด และลักษณะ
หัวแปรง, โหมดในการระบายความโปร่งใสของสี และอัตราการไหลของสี เป็นต้น 

เครื่องมือพ้ืนฐานของโปรแกรม Adobe Photoshop CS6 

 Tool Panel (ทูลพาเนล) หรือ กลอ่งเครื่องมือ จะประกอบไปด้วยเครื่องมือต่าง ๆ ที่ใช้ใน
การวาด ตกแต่ง และแก้ไขภาพ เครื่องมอืเหล่าน้ีมีจ านวนมาก ดังนั้นจึงมีการรวมเครื่องมือที่ท าหน้าที่
คล้าย ๆ กันไว้ในปุ่มเดียวกัน โดยจะมีลักษณะรูปสามเหลี่ยมอยู่บริเวณมุมด้านล่างดังภาพ  เพื่อบอก
ให้รู้ว่าในปุ่มนี้ยังมีเครื่องมืออื่นอยู่ด้วย 

 

 

 

 

 

 

 

ภาพที่ 3 Tool Panel หรอืกล่องเครื่องมือ 
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ท าการแบง่กลุ่มเครื่องมือได้ดังภาพต่อไปนี ้

 

 

 

 

 

 

 

 

 

ภาพที่ 4 กลุ่มค าสั่งเครื่องมือ Tool Box 

เครื่องมือแต่ละช้ินมีคุณสมบัติดังนี ้

 

 

ภาพที่ 5 Move 
ใช้ส าหรบัเลือกพื้นที่บนภาพเป็นรูปสี่เหลี่ยม วงกลม วงรี หรอืเลือกเป็นแถวคอลัมน์  ขนาด 1 พิกเซล 

 

 

 

ภาพที่ 6 Marquee 
   ใช้ส าหรับย้ายพื้นที่ทีเ่ลอืกไว้ของภาพ หรือย้ายภาพในเลเยอร์หรือย้ายเส้นไกด์ 
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ภาพที่ 7 Lasso 
ใช้เลือกพื้นที่บนภาพเป็นแนวเขตแบบอิสระ 

                                             

 

 
ภาพที่ 8 Magic Wand 

ใช้เลือกพื้นที่ด้วยวิธีระบายบนภาพ หรือเลือกจากสีที่ใกล้เคียงกัน 
 

 

 
ภาพที่ 9 Crop 

ใช้ตัดขอบภาพ 
 

 

                                                

 
ภาพที่ 10 Slice 

ใช้ตัดแบ่งภาพเพื่อบันทึกไฟล์ภาพย่อย ๆ ที่เรียกว่าสไลซ์ (Slice)ส าหรบัน าไปสร้างเว็บเพจ 
 

 

 

 
ภาพที่ 11 Eyedropper 

ใช้เลือกสีจากสีต่าง ๆ บนภาพ 
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ภาพที่ 12 Healing Brush 
ใช้ตกแต่งลบรอยต าหนิในภาพ 

 
 

 

 
ภาพที่ 13 Brush 

ใช้ระบายลงบนภาพ 
 

 

 

ภาพที่ 14 Clone Stamp 
ใช้ท าส าเนาภาพ โดยก๊อปปี้ภาพจากบรเิวณอื่นมาระบาย หรือระบายด้วยลวดลาย 

 
 

 

 

ภาพที่ 15 History Brush 
ใช้ระบายภาพด้วยภาพของข้ันตอนเดิมทีผ่่านมา หรือภาพของสถานะเดิมทีบ่ันทึกไว้ 

 
 
 

 
 

ภาพที่ 16 Eraser 
ใช้ลบภาพบางส่วนที่ไม่ต้องการ 
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ภาพที่ 17Gradient 
ใช้เติมสีแบบไลร่ะดับโทนสหีรอืความทึบ  

 
 
 
 
 

ภาพที่ 18 Blur 
ใช้ระบายภาพให้เบลอ 

 
 

 

 

ภาพที่ 19 Bern 
ใช้ระบายเพือ่ให้ภาพมืดลง 

 
 

 

 

 

ภาพที่ 20 Dodge  
ใช้ระบายเพือ่ให้ภาพสว่างขึ้น 
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ภาพที่ 21 pen 
ใช้วาดเส้นพาธ (Path) 

 
 

 

 

ภาพที่ 22 Horizontal Type 
ใช้พิมพ์ตัวอักษรหรือข้อความลงบนภาพ 

 
 

 

 

ภาพที่ 23 Path Selection 
ใช้เลือกและปรับแต่งรูปทรงของเส้นพาธ 

 
 

 

 

ภาพที่ 24 Rectangle 
ใช้วาดรูปทรงเรขาคณิตหรือรปูทรงส าเร็จรูป 

 
 

 

 

ภาพที่ 25 Hand 
ใช้เลื่อนดูส่วนต่าง ๆ ของภาพ 
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ภาพที่ 26 Zoom 
ใช้ย่อหรือขยายมุมมองภาพ 

 
 

 

 

 

ภาพที่ 27 set Foreground Color, Set Background Color ใช้ส าหรบัก าหนดสี  

Foreground Color และ  Background Color 

 

 

 

ภาพที่ 28 เปิดแสดงหน้ากระดาษ แบบ Full screen 

ความสามารถของโปรแกรม Adobe Photoshop CS6  

- ตกแต่งหรอืแก้ไขรูปภาพ 

- ตัดต่อภาพบางส่วน หรือทีเ่รียกว่า crop ภาพ 

- เปลี่ยนแปลงสีของภาพ จากสีหนึง่เป็นอีกสีหนึง่ได้ 

- สามารถลากเส้น แบบฟรสีไตล์ หรือใสรู่ปภาพ สีเ่หลี่ยม วงกลม หรือสร้างภาพได้
อย่างอิสระ 

- มีการแบง่ช้ันของภาพเป็น Layer สามารถเคลื่อนย้ายภาพได้เป็นอสิระตอ่กัน 

- การท า cloning ภาพ หรือการท าภาพซ้ าในรปูภาพเดียวกัน 

- เพิ่มเตมิข้อความ ใส่ effect ของข้อความได้ 
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- Brush หรือแปรงทาสี ที่สามารถเลือกรูปแบบส าเร็จรูปในการสร้างภาพได้ 
และอื่นๆ อีกมากมาย 

นอกจากนี้ ยังมีโปรแกรมเสรมิที่ช่วยให้การตกแต่งภาพด้วย Photoshop เป็นเรือ่งง่ายๆ อีก นั่นคือ 
Plug-ins ของ Photoshop ซึ่งได้แก่ การปรบัภาพจากภาพถ่าย มาเป็นภาพแบบวาดด้วยสีน้ า ภาพ
ลายการ์ตูน เป็นภาพลายเส้น เป็นต้น ส าหรับ Plug-ins ที่เป็นที่นิยมใช้กับ Photoshop ได้แก่ 

- AlienSkin Eye Candy 

- Extensis Photo Frame 

- Extensis Photo Graphics 

- Extensis Photo Tools 

- Kai's Power Tools 

คุณสมบัติของโปรแกรม Adobe Photoshop CS6  

โปรแกรม Photo shop เป็นโปรแกรมในตระกูล Adobe ที่ใช้ส าหรบัตกแต่งภาพถ่ายและ
ภาพกราฟฟิก ได้อย่างมปีระสทิธิภาพ ไม่ว่าจะเป็นงานด้านสิ่งพมิพ์ นิตยสาร และงานด้านมลัติมเีดีย 
อีกทั้งยงัสามารถ retouching ตกแต่งภาพและการสร้างภาพ ซึ่งก าลงัเป็นที่มนิยมสงูมากในขณะนี้ 
เราสามารถใช้โปรแกรม Photoshop ในการตกแต่งภาพ การใส่ Effect ต่าง ๆให้กบัภาพ และ
ตัวหนังสือ การท าภาพขาวด า การท าภาพถ่ายเป็นภาพเขียน การน าภาพมารวมกัน การ Retouch 
ตกแต่งภาพต่าง  

เราสามารถเรียนรู้วิธีการใช้โปรแกรม Adobe Photoshop นีไ้ด้ด้วยตัวเอง  คุณสามารถที่จะ
ท าการแก้ไขภาพ ตกแต่งภาพ ซ้อนภาพในรูปแบบต่างๆ ได้อย่างง่ายดาย และสิ่งที่ขาดไม่ได้ก็คือ การ
ใส่ข้อความประกอบลงในภาพด้วย  และเนื่องด้วย Adobe Photoshop มีการพัฒนาโปรแกรมมา
อย่างต่อเนื่อง ท าใหเ้ราจ าเป็นต้องศึกษาค าสัง่ต่างๆ ใหเ้ข้าใจ แต่ที่ส าคัญ เมือ่คุณเรียนรู้การใช้ค าสั่งใน
เวอร์ช่ันเก่า คุณก็ยังคงสามารถน าไปประยุกต์ใช้กับเวอร์ช่ันใหม่ๆ ได้ด้วย 
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ความหมายและความส าคัญของ Layer โปรแกรม Adobe Photoshop CS6 

        Layer ช้ินงานย่อย หรือเรียกให้เข้าใจง่ายคือ ช้ันของช้ินงานใหญ่ เป็นหลักการท างาน
ของโปรแกรม Photoshop นั่นคือการน าช้ันต่างๆ มาผสมกนัเพื่อปรับแตง่ให้เกิดความสวยงามมาก
ข้ึน 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 29 หน้าต่างแสดง Layer 

สามารถท าอะไรกบัเลเยอร ์
แสดงหรือซ่อน (Show or Hide Layer) การคลิกทีร่ปูดวงตาแต่ละครั้ง จะเป็นการเปิดเพื่อแสดง หรือ
ปิดเพื่อซ่อนสิ่งที่อยู่ในเลเยอร์ เช่น ถ้าเราไม่ต้องการให้แสดงภาพของเลเยอร์ใดก็ท าการปิดหรือซ่อน
ไป 
คัดลอก และ ท าซ้ าเลเยอร์ (Copy and Duplicate Layer) แบ่งเป็น การคัดลอกแลเยอรจ์ากช้ินงาน
หนึ่งไปยงัอีกช้ินงานหนึ่ง ท าได้หลายวิธี 

คลิกเลเยอร์ที่ต้องการท าการคัดลอก ใช้โปรแกรมเมนู Edit เลือก Copy หรือกดปุ่ม Ctrl C 
คลิก Tab ของช้ินงานที่เราต้องการจะใหเ้ลเยอร์นั้นมาวางไว้แล้วคลิก Edit เลือก Paste หรือ
กดปุ่ม Ctrl V   
  
คลิกเลเยอร์ที่ต้องการท าการคัดลอก คลกิขวาที่เม้าส์ เลือก Duplicate Layer จะได้หน้าต่าง
ตามภาพด้านล่าง ใส่ช่ือในช่อง Destination ให้เป็นช่ือช้ินงานที่เราต้องการน าเลเยอร์นี้ไปไว้ 
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คลิกเลเยอร์ที่ต้องการท าการคัดลอกค้างไว้ แล้วลากไปยังอกี Tab ของอีกช้ินหนึง่โดยตรง 
 
 

 

 

 

 

 

ภาพที่ 30 การคัดลอก Layer 

การคัดลอกเลเยอร์ในชิ้นงานเดียวกัน 

- คลิกที่เลเยอร์ ใช้โปรแกรมเมนู Layer เลอืก Duplicate Layer จะมีหน้าต่างเหมือนภาพที่
ด้านบนเช่นกัน แต่ช่อง Destination ไม่ต้องก าหนดช่ือช้ินงานอื่น 

-  คลิกที่เลเยอร์ ใช้โปรแกรมเมนู Layer เลือก New เลือก Layer via Copy (คีย์ลัด Ctrl + J) 

- คลิกที่เลเยอร์นั้น และกดคีย์ Alt พร้อมกับลากเลเยอร์ไปยงัต าแหน่งใน Panel ที่ต้องการวาง 
ปล่อยเม้าส ์

ย้ายต าแหน่งเลเยอร์ (Move Layer) 

ข้ันตอนการท าคล้ายกับการคัดลอก เพียงเปลี่ยนค าสัง่จาก Edit - Copy เป็น Edit Cut หรือ 
Ctrl X ในกรณีที่ย้ายคนละช้ินงาน แต่ถ้าช้ินงานเดียวกันเพียงคลิกทีเ่ลเยอร์ และท าการเลื่อนไปยัง
ต าแหน่งบน Panel ที่ต้องการเท่านั้น 

เพ่ิมเลเยอร์ (Add Layer) 

เพียงแค่คลิกไอคอน Create a new Layer ซึ่งอยู่ด้านล่างของ Layer Panel ติดกับรูปถัง ก็
จะได้เลเยอร์เพิม่แล้ว หรือถ้าต้องการใช้ค าสั่งจากเมนูโปรแกรม เลือก Layer เลือก New เลือก 
Layer ตั้งช่ือ และ Enter ก็ได้เหมือนกัน   
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ลบเลเยอร์ (Delete Layer) 
วิธีลบเลเยอร์ท าโดย คลิกที่เลเยอร์ที่ตอ้งการลบ กดปุ่ม Backspace หรือใช้โปรแกรมเมนู 

Layer เลอืก Delete เลอืก Layer หรือโดยการคลกิที่เลเยอร์แล้วลากมาทีรู่ปถัง 
การล็อค และ ปลดล็อค เลเยอร์ (Lock and Unlock Layer) 

การลอ็คเลเยอร์ ท าได้โดย คลิกที่เลเยอรท์ี่ต้องการลอ็ค แล้วคลิกทีรู่ปกญุแจ ส่วนการปลด
ล็อคก็เพียงท าซ้ าข้ันตอนเดียวกัน 
การปลดล็อคเลเยอร์  Background  

วิธีปลดล็อคท าได้โดย ดับเบิล้คลิกที่เลเยอร์ จะมีหน้าต่างดงัภาพข้ึนมา จะตั้งช่ือเลเยอร์ใหม่
หรือไมก่็ได้ เลเยอร์นั้นกจ็ะปลดล็อคเป็นเลเยอร์ธรรมดา 
ตั้งชื่อเลเยอร์ (Name Layer) 

วิธีตั้งช่ือให้กับเลเยอร์ ท าโดยดับเบิ้ลคลิกที่ช่ือบนเลเยอร์นัน้ และพิมพ์ช่ือ เสร็จแล้ว Enter 
ส าหรับ Photoshop CS6 เมื่อพิมพ์ช่ือเลเยอร์หนึง่เสรจ็แลว้ สามารถกด Tab เพื่อเลื่อนไปยังเลเยอร์
อื่นเพื่อท าการพมิพ์ช่ือได้เลย ไม่ต้องมาท าซ้ าข้ันตอนเดิม ท าให้ประหยัดเวลาได้มาก 
คลิปป้ิงเลเยอร์ (Clipping Layer) 

หมายถึงการท าใหเ้ลเยอร์หนึง่มผีลกับอีกเลเยอร์หนึง่เท่านั้น ไม่ไปกระทบเลเยอรอ์ื่นซึ่งอยู่ถัด
ลงไป อ่านแล้วคงจะ งง ลองดูภาพด้านล่างนะครับ จากภาพจะเห็นเลเยอร์ Wood Gain ซึ่งเป็นลาย
ไม้ ผมต้องการใหล้ายไม้นี้มผีลกับกรอบภาพซึ่งเป็นเลเยอร์ Frame ที่อยู่ถัดลงไปด้านล่างเท่านั้น ผม
จึงใช้การ Clipping ซึ่งจะเห็นลูกศรอยู่ที่ด้านหน้านของเลเยอร์ Wood Gain การท าเช่นน้ี จะท าให้ได้
กรอบภาพที่มลีายไม้สวยงามขึ้นมาแทนกรอบสีแดงเหลือง ในเลเยอร์ Frame 

การท า Clipping โดยการใช้คีย์ลัด ให้กดปุ่ม Alt แล้ววางเม้าส์ไว้ระหว่างทัง้สองเลเยอร ์
จากนั้นคลิก หรือถ้าจะใช้ค าสั่งโปรแกรมเมนู Layer เลือก Create Clipping Mask (คีย์ลัด Alt + 
Ctrl + G) ถ้าต้องการยกเลิกก็เพียงแค่ท าซ้ าวิธีเดิม โปรแกรมเมนู Layer เลือก Release Clipping 
Mask หรอื กดปุ่ม Alt แล้วคลิกเม้าส์ทีเ่ดิมอีกครั้ง 
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ประโยชน์ของโปรแกรมAdobe Photoshop CS6 
1.เป็นที่ดูไฟล์ภาพได้อย่างมปีระสิทธิภาพ  

ความสามารถนี้หมายรวมไปถงึการที่เราสามารถเสียบสายจากกล้องดิจทิัลแล้วสามารถดึง 
ภาพมาไว้ที่ Adobe Bridge ได้เลย หรือจะท าการ download ภาพจาก Card reader ก็ได ้
เพราะ Adobe ได้เพิ่มความสามารถ Adobe Photo Downloader (APD) มาใน Adobe  
Bridge และสามารถ Preview ภาพได้อย่างรวดเร็วทั้งไฟล์ jpg หรือ RAW file นอกจากนี ้
ยังสามารถดูภาพให้ถูกต้องตาม profile ภาพที่ฝังมาได้ด้วย และยังสามารถท าการเปรียบ 
เทียบภาพของภาพแต่ละภาพได้คล้ายกบัความสามารถใน Adobe Lightroom นอกจากนี้ยัง 
สามารถ Zoom ดูภาพเฉพาะจุดได้อีกด้วย และเนือ่งจาก Adobe Bridge สามารถ preview  
ไฟล์ ai, pdf ได้ ดังนั้นความสามารถที่ใช้กับภาพกส็ามารถใช้ได้กับไฟล์เหล่าน้ีด้วย 
2.ปรบัปรุงหน้าตาใหม่  

ในเวอร์ช่ันน้ีมีการปรับปรุงหน้าตาของกรอบเมนูต่างๆ ใหม ่ มี Dock ส าหรบัใส่ icon ของ
เมนูต่างๆ เพื่อใหผู้้ใช้งานสามารถเลือก palettes ออกมาใช้งานได้สะดวกขึ้น อย่างไรก็ตาม 
ส าหรับผู้ที่ไม่คุ้นเคยกบั palettes หรือผู้ที่คลอ่งในการใช้ Shortcut อาจต้องท าความคุ้นเคย 
กับสญัลกัษณ์ของ icon กันพอสมควร 
3.เปิดภาพ .jpg หรอื tiff ให้เป็น RAW ไฟล์ได้  

ใครที่นิยมปรับแตง่ภาพแบบ raw fie ในเวอร์ชันน้ีสามารถใช Adobe Photoshop เปิดภาพ 
ที่เป็น jpg หรือ tif ให้เป็น Format Photoshop Raw ได้ และหลังจากปรบัแต่งแล้วยังสามารถ 
Save ไปเป็น dng ได้อีกด้วย 
4.ปรบัการต่อภาพแตล่ะเลเยอร์อัตโนมัติ  

ความสามารถนี้เหมาะส าหรับผู้ที่ช่ืนชอบการต่อภาพด้วยค าสั่ง Photomerge เพราะคราวนี้ 
หลงัจากที่เราเลือกค าสัง่ Automate>Photomerge ก็จะมคี าสั่ง Auto Align Leyer มาให้  
หรือเมื่อเราท างานน าภาพหลายๆ ภาพ มาประกอบกันเป็นหลาย layer ก็สามารถใช้ค าสั่งนี ้
ได้ที่ Edit> Auto-Align Layers นอกจากนั้นยังสามารเกลี่ยภาพของแต่ละ Layer ให้กลม 
กลืนกันได้ด้วย Edit>Auto-Blend Layers 
5.ปรบัภาพขาวด า  

ง่ายและเนยีนกว่าเดิมเมื่อต้องการปรบัภาพเป็นขาวด าด้วยค าสั่งใหม่ที่  
Image>Adjustment>Black and White จะข้ึนหน้าต่างมาให้ปรบัภาพได้อย่างง่ายๆ  
สามารถตรวจสอบน้ าหนักของภาพ ได้สะดวกขึ้น หรือต้องการเป็นภาพสีเดียวที่ไม่ใช่ขาวด า 
ก็เลอืกตรงค าสั่ง Tint ก็สามารถปรบัภาพเป็น Tone สีต่างๆ ได้อย่างง่ายดาย 
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 6.Curves และ Channel Mixer อัจฉริยะข้ึนมาก  
การเลือกปรบัภาพด้วย Curves จะมีการเปลี่ยนหน้าตาของวินโดวส์ใหญ่ข้ึนและมี  

Histogram ปรากฎให้เห็นเป็นพื้นหลัง นอกจากนี้ในส่วนของ Preset ก็มีค่า default มาให ้
เลือกใช้ได้ เช่นเดียวกับการใช้ค าสั่ง Channel Mixer ก็เช่นเดยีวกัน 
 7.เลือกสิ่งที่ต้องการได้ง่ายและสะดวก  

ผู้ที่ต้องใช้งาน Di-cut คงจะดีใจเมื่อเห็นเครื่องมือใหม่ Quick Selection Tool ที่ท างาน 
เหมอืนการใช้ Quick Mask แต่เป็นการใช้เครื่องมือ Select ที่เป็นเหมือนพู่กันไล่ไปตาม 
ขอบของวัตถุ การเลือกพื้นที่ความละเอียดข้ึนอยู่กบัการปรบัขนาดของ Tool เหมอืนกับการ 
ปรับขนาดพูก่ัน ใช้งานง่าย เมื่อเลือกใช้แล้วจะปรากฎความสามารถใหม่ขึ้นมาทีเ่รียกว่า  
Refine Edge ที่ช่วยให้การเลือกพื้นที่ที่ต้องการปรับเปลี่ยนไปเป็น Mask, Quick Mask ....  
และสามารถก าหนดลักษณะขอบของพื้นที่ที่เลือกให้เป็นแบบนุ่มนวล หรือเป็น Feather ก็ 
ได ้
 8.Clone Stamp ที่ง่ายส าหรบัมือใหม่  

ง่ายจรงิๆ ส าหรบัมือใหมท่ี่ต้องการจะท าการแต่งภาพด้วยเครื่องมอื Clone stamp ลองนกึ 
ภาพดูหากเรามีภาพ Portrait บุคคล แล้วต้องการจะท าตาให้มีสี่ตา เราเพียงแค่น าภาพน้ีเป็น 
สองภาพ แล้วเอามาซ้อนกันส่องดูกับแสงแดดว่าได้ต าแหน่งที่ต้องการหรือยัง เมื่อได้แล้วก็ 
ท าการกดภาพลงไปให้ติดกันกจ็ะได้อย่างที่ตอ้งการ 
9.งานตกแต่งภาพถ่าย  

เป็นการตกแต่งภาพถ่ายเก่า ๆ ให้คมชัดเหมือนใหม่ หรือท าการแก้ไขรูปถ่ายที่มืดไป สว่างไป 
มีเงาด าให้ภาพมีสสีันสดใสสมจริง นอกจากนั้นยังสร้างภาพล้อเลียน เช่น เอาใบหน้าของคนหนึง่ไป
วางไว้บนตัวคนอีกคนหนึ่ง น าภาพบุคคลไปวางบนฉากหลังอื่น เป็นต้น 
10.งานสิ่งพิมพ์  

ไม่ว่าจะเป็นหนังสือ นิตยสาร โฆษณา เรียกได้ว่าเกือบทุกงานที่ต้องใช้รปู สามารถใช้ 
Photoshop รังสรรค์ภาพใหเ้ป็นไปตามไอเดียทีเ่ราวางไว้ได ้
11.งานเว็บไซด์บนอินเตอร์เน็ต  

ใช้สร้างภาพเพื่อตกแต่งเว็บไซด์ไม่ว่าจะเป็นเบ็คกราวด์ ปุ่มตอบโต้ แถบหัวเรื่อง ตลอดจน
ภาพประกอบต่าง ๆ นอกจากนั้นยงัสมารถออกแบบหน้าเว็บไซด์ด้วย Photoshop ได ้
12. งานออกแบบทางกราฟิก  

ใช้ Photoshop ช่วยในการสร้างภาพ 3 มิติ การออกแบบปกหนงัสือและผลิตภัณฑ์ การ
ออกแบบการ์ดอวยพร เป็นต้น 
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การเปิดพ้ืนท่ีการใช้งาน การน าภาพเข้าใช้งาน และการบันทึกงาน  

การเปิดพื้นที่การใช้งานใหม ่

1. ไปที่ Application menu เลือก File > New จะปรากฏหน้าต่างดังรปูด่านล่าง 

 

 

 

 

 

 

 

 

ภาพที่ 31 การสร้างพื้นที่การใช้งาน 

2. จากรปูมีการก าหนดค่าต่างๆมากมาย 

- ช่อง Name คือการก าหนดช่ือของช้ินงาน 

- ช่อง Preset คือ ชนิดของงานต่างๆ ที่ก าหนดไว้ให้แล้ว มีใหเ้ลือกมากมาย เช่น Web , 
Photo ,U.S.paper , international paper 

- ช่อง size จะสมัพันธ์กับช่อง Preset คือ ขนาดของงานแต่ละชนิด เช่น ค่า Preset เป็น 
International paper ช่อง Size ก็จะมีตัวเลอืก คือ A4 , A3 , A2 ,A1 และอื่นๆ 

- ช่อง width คือขนาดความกว้างของช้ินงาน หากต้องการก าหนดเอง มีหน่วนใหเ้ลือก 7 ชนิด 

- ช่อง Hight คือขนาดความสูงของช้ินงาน  

- ช่อง Resolution คือ ความละเอียดของงาน มหีน่วยเป็น Pixelต่อน้ิว และ Pixel ต่อ
เซนติเมตร 
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- ช่อง Color mode คือชนิดของพื้นที่สีในการท างาน มีให้เลอืกหลากหลาย เช่น RGB , 
CMYK และมีค่าความละเอียดให้เลือกเป็น bit 

- ช่อง Background Contents คือเลอืกชนิดของ พื้นหลังงาน มี 3 แบบ คือ แบบขาว แบบสี 
และแบบโปร่งใส 

          เมื่อท าการก าหนดขนาดของงานเสร็จเรียบรอ้ยแล้ว ให้คลิปปุม่ OK เพื่อท าการเปิดพื้นที่
การท างานดงัตัวอย่างภาพ เปิดพื้นที่งานขนาด A4 พื้นหลัง สีขาว 

 
 

  
 
 
 
 
 
 
 
 
 

ภาพที่ 32 พื้นที่การท างาน 
การน าภาพเข้าใช้งาน 
      หากเรามีภาพที่ต้องการเปิดเข้าใช้งานในโปรแกรม ในท าการ ตามขั้นตอนต่อไปนี ้
       ไปที่ File > open เลอืก Floder ที่มีรูปที่เราต้องการ เลือกรูปนั้นแล้วกด Open 

 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 33 หน้าจอแสดงเมื่อต้องการเลือกรูป 
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จะได้รูปมาปรากฎอยู่ที่ Stage หรือพื้นทีก่ารท างานดังรูป ตามตัวอย่างด้านล่าง ใช้รูปดอกบัว 
 
 
 

 

 

 

 

 

ภาพที่ 34 รูปที่ต้องการจะปรากฏอยู่ที ่Stage 

การบันทึกงาน 

     สมมุติว่า เราได้แต่งรูป พระทราย ดังตัวอย่างภาพด้านลา่ง เสร็จเรียบร้อยแล้ว เราต้องการบันทึก
การท างาน ท าตามขั้นตอนดงัต่อไปนี ้

 

 

 

 

 

 

ภาพที่ 35 ตัวอย่างรูปที่เสรจ็เรียบร้อยแล้ว 
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ไปที่ File > Save as จะปรากฏหน้าต่างดังรปูด้านล่าง 

- ช่อง File name คือให้เราต้ังช่ืองาน 

- ช่อง Format คือ การบันทกึไฟลง์านประเภทต่างๆ เช่น PSD , JPEG , TIFF และอื่นๆ  

- เมื่อเลือกเสรจ็เรียบร้อยแล้ว กด Save ก็จะท าการบันทึกส าเรจ็ 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 36 การบันทึกไฟลง์าน 
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บทท่ี 3 
วิธีการด าเนินงานโครงการ 

 

โครงการศึกษาการสร้างสือ่การเรียนรู้เรื่อง เรื่อง การออกแบบป้ายโฆษณาด้วยโปรแกรม 
Adobe Photoshop CS6 มีขั้นตอนและวิธีการด าเนินงานเรียงตามล าดับดังนี ้
 3.1 ศึกษาค้นคว้าข้อมูล 
 3.2 การออกแบบโครงการ 
 3.3 วิธีการด าเนินโครงการ 
 3.4 ข้ันตอนการประเมินผลงาน 
 3.5 ข้ันตอนการปรบัปรุง 
 
ศึกษาค้นคว้าข้อมูล 

3.1.1 ความหมายของโปรแกรม Adobe Photoshop CS6 
3.1.2 ส่วนประกอบของโปรแกรม Adobe Photoshop CS6 

 3.1.3 เครื่องมอืพื้นฐานของโปรแกรม Adobe Photoshop CS6 
3.1.4 ความสามารถของโปรแกรม Adobe Photoshop CS6 

 3.1.5 คุณสมบัติของโปรแกรม Adobe Photoshop CS6 
 3.1.6 ความหมายและความส าคัญของ Layer โปรแกรม Adobe Photoshop CS6 

3.1.7 ประโยชน์ของโปรแกรม Adobe Photoshop CS6 
3.1.8 การเปิดพื้นที่การใช้งาน การน าภาพเข้าใช้งาน และการบันทกึงานงาน 

 
การออกแบบโครงการ 

ผู้จัดท าโครงการได้มีการออกแบบโครงการโดยมลีักษณะ ดังนี้ 
1. โปรแกรม Adobe Photoshop CS6 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 37 แสดงภาพหน้าต่างของโปรแกรม Adobe Photoshop CS6 
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2. เครื่องมอืที่ใช้สร้างผลงาน 
1) Menu Bar เป็นแถบเครื่องมือที่ใช้ส าหรับรวบรวมค าสั่งยอ่ยทั้งหมด 

 
ภาพที่ 38 แสดงแถบเครื่องมือ Menu Bar 

2) Tool Panel (ทูลพาเนล) หรือ กล่องเครื่องมือ จะประกอบไปด้วยเครือ่งมือ
ต่าง ๆ ที่ใช้ในการวาด ตกแต่ง และแก้ไขภาพ เครื่องมือเหลา่น้ีมีจ านวนมาก 
ดังนั้นจึงมีการรวมเครื่องมือทีท่ าหน้าที่คล้าย ๆ กันไว้ในปุ่มเดียวกัน โดยจะมี
ลักษณะรปูสามเหลี่ยมอยู่บริเวณมุมด้านล่างดงัภาพ  เพื่อบอกให้รู้ว่าในปุม่นี้ยัง
มีเครื่องมืออื่นอยู่ด้วย 

 
 
 
 
 
 
 
 
 
 

 

 

 

ภาพที่ 39 ภาพแถบเครื่องมือ Tool Panel (ทูลพาเนล) 
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3) Panel menu (พาเนล) เป็นวินโดว์ย่อย ๆ ที่ใช้เลอืกรายละเอียด หรือค าสั่งควบคุมการท างานต่าง 
ๆ ของโปรแกรม ใน Photoshop มีพาเนลอยู่เป็นจ านวนมาก เช่น พาเนล Color ใช้ส าหรบัเลือกส,ี 
พาเนล Layers ใช้ส าหรบัจัดการกบัเลเยอร์ และพาเนล Info ใช้แสดงค่าสีตรงต าแหน่งที่ช้ีเมาส์ 
รวมถึงขนาด/ต าแหน่งของพื้นที่ทีเ่ลือกไว้ 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 40 แสดงแถบเครื่องมือ Panel menu 
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วิธีการด าเนินโครงการ 
1. โครงการเรือ่งการออกแบบป้ายโฆษณาด้วยโปรแกรม Adobe Photoshop CS6 
2. วิธีการด าเนินโครงการ 
 
 

1). เปิดโปรแกรม  Adobe Photoshop CS6 โดยไปที่ Window คลิกที่ตัวโปรแกรม 
 
 

 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 41 ภาพการเข้าโปรแกรม  

 
 2) หน้าต่างโปรแกรม 
 

 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 42 ภาพหน้าต่างโปรแกรม 
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3) เมื่อเข้าโปรแกรมแล้ว ให้เลอืกที ่File>New เพื่อท าการสร้างหน้ากระดาษ 

 
ภาพที่ 43 แสดงการสร้างหน้ากระดาษ 

 
4) ตั้งช่ือหน้ากระดาษตามที่เราต้องการ 
 
 
 
 
 
 
 
 
 
 
 

 
 

ภาพที่ 44 แสดงการตั้งช่ือหน้ากระดาษ 
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5) จากนั้นให้ตั้งค่าหน้ากระดาษ สูง 1080 กว้าง 1920 Resolution 72 
 

 
 

ภาพที่ 45 การตั้งค่าความสงู ความกว้าง และResolution 
 
6) จากนั้นจะไดห้น้ากระดาษทีเ่ป็นสีขาวดังรปู 

 
ภาพที่ 46 หน้ากระดาษที่ท าการสร้าง 
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7) จากนั้นจะท าการใส่ background ให้กับหน้ากระดาษ 
 

  
ภาพที่ 47 แสดงภาพการใส่ background 

 
 8) ไปที่เครื่องมือ Type Tool เพื่อใสห่ัวข้อโฆษณาที่เราต้องการ 
 

 
ภาพที่ 48 การใส่ข้อความโดยใช้เครื่องมือ Type Tool 
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9) จากนั้นให้พมิพ์หัวข้อโฆษณาที่เราต้องการแล้วจัดวางใหเ้หมาะสม  
 

 
ภาพที่ 49 แสดงการใส่ข้อความ 

 
 10) ไปที่ Add a Layer stay 

 
ภาพที่ 50 เครื่องมือ Add aLayer stay 
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11) คลิกที่ Blennding Option 

 
ภาพที่ 51 การใส่ Blending Option 

 
12) จะเจอหน้าต่างโปรแกรมให้คลกิที่ Storke เพื่อใส่ขอบให้ข้อความ 
                                                                                                                     

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

ภาพที่ 52 การใส่ขอบให้ข้อความ 
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13) ไปที่ color เพื่อเปลี่ยนสีให้กบัขอบข้อความ 
 

 
 

ภาพที่ 53 การเปลี่ยนสีใหก้ับขอบข้อความ 
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14) จากนั้นให้ไปที่ Size แล้วเลือ่นเพือ่ขยายความหนาให้กบัขอบข้อความแล้วกด OK 
 

 
ภาพที่ 54 ขยายความหนาขอบข้อความ 
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15) หลังจากทีเ่ราได้ท าการปรับแตง่หัวข้อโฆษณาให้เกิดความสวยงามแล้วต่อไปให้ใส่พื้นหลังที่เรา
ต้องการให้กับเนื้อหาที่เราจะท าการใสล่งไปในป้ายโฆษณา 

 

ภาพที่ 55 พื้นหลังส าหรบัใสเ่นื้อหาให้กบัป้ายโฆษณา 

16) ไปที่เครื่องมือ Type Tool อีกครั้ง เพือ่เพิม่เนื้อหาใหก้บัป้ายโฆษณาและท าการปรบัแต่งให้
สวยงาม 

 

ภาพที่ 56 ใส่เนื้อหาให้กบัป้ายโฆษณา 
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17) หลังจากทีเ่ราใส่เนื้อหาใหก้ับป้ายโฆษณาเสร็จแล้วต่อไปให้น ารูปที่เราต้องการใหม้ีในป้ายโฆษณา
มาใส ่

 

ภาพที่ 57 ใส่รูปภาพให้กบัป้ายโฆษณา 

18) ไปที่เครื่องมือ Type Tool อีกครั้ง เพือ่ใส่ข้อมลูส าหรับติดต่อสอบถาม 

 

ภาพที่ 58 ใส่ข้อมูลติดต่อสอบถาม 
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19) เมื่อเสรจ็เรียบร้อยแล้วเราจะท าการเซฟไฟล์โดยไปที่ File>Save As แล้วท าการเปลี่ยนช่ือ 
เปลี่ยน Fomat เป็น PSD ส าหรบัไว้ใช้แก้ไข และ JPEG ส าหรบับันทกึเป็นงานทีเ่สร็จสมบูรณ์ไม่
สามารถแก้ไขได ้

 

 

 

 

 

 

 

 

 

ภาพที่ 59 การเซฟไฟลง์าน 
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บทที่ 4 
ผลของการด าเนินงาน 

 

ในการวิเคราะห์ข้อมูล  “การออกแบบป้ายโฆษณาโดยใช้โปรแกรม Adobe Photoshop CS6”ของ

นักศึกษาวิทยาลัยเทคโนโลยีอักษรบริหารธุรกิจ จังหวัดระยอง ทางกลุ่มผู้ศึกษาจัดท าโครงการ ได้

น าเสนอผลการวิเคราะห์ข้อมูลที่ได้ด าเนินการตามล าดับ ดังต่อไปนี้ 

 สัญลักษณ์ในการวิเคราะห์ข้อมูล 
ในการวิเคราะห์ข้อมูลเพื่อให้เกิดความเข้าใจในการแปลความหมาย ได้ก าหนดสัญลักษณ์ใน

การวิเคราะห์ข้อมูล ดังนี้ 
ตัวอย่าง              N     แทน     จ านวนคนในกลุ่ม 

                                         แทน     ค่าเฉลี่ย  (Mean) 
                                  %    แทน     ร้อยละ  (เปอร์เซ็นต)์ 

  
การเสนอผลการวิเคราะห์ 

คณะผู้จัดท าได้น าเสนอผลการวิเคราะห์ข้อมูลตามความมุ่งหมายของการใช้โปรแกรม 
โปรแกรม Adobe Photoshop CS6 และแปลผลจากแบบสอบถามที่เก็บรวบรวมจากกลุ่มตัวอย่าง
โดยแบ่งออกเป็น 2 ตอนดังนี้ 
        ตอนที่  1  ผลการวิเคราะห์ข้อมูลสภาพทั่วไปของกลุ่มตัวอย่าง  ได้แก่ เพศ อายุ  อาชีพ 
และ ทักษะทางคอมพิวเตอร์ 
        ตอนที่  2  ผลการวิเคราะห์ค่าเฉลี่ยของการสอบถามความคิดเห็นของนักเรียน–นักศึกษา
เกี่ยวกับการน าเสนอ โดยใช้โปรแกรม Adobe Photoshop CS6 ของนักเรียน – นักศึกษา 
ประกาศนียบัตรวิชาชีพชั้นปีที่ 2 ภาคพิเศษ วิทยาลัยเทคโนโลยีอักษรบริหารธุรกิจ จังหวัดระยอง 

   
ตอนที่ 1 ผลการวิเคราะห์ข้อมูลสภาพทั่วไปของกลุ่มตัวอย่าง ได้แก่ เพศ อายุ สถานภาพ 

อาชีพ และรายได้ 
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ตารางท่ี  1 จ าแนกร้อยละของสภาพทั่วไปของกลุ่มตัวอย่าง จ าแนกตาม เพศ 

เพศ จ านวน ( คน ) ร้อยละ (%) 

ชาย 7 28 

หญิง 18 72 

รวม 25 100 

 
 
จากตารางที่ 1 พบว่าสถานภาพทั่วไปของกลุ่มตัวอย่างนักเรียน-นักศึกษา จ าแนกตาม เพศ 

จาก กลุ่มตัวอย่างทั้งสิ้น จ านวน 25 คน 

-          เพศชาย จ านวน 7 คน คิดเป็นร้อยละ 28 

-          เพศหญิงจ านวน 18 คน คิดเป็นร้อยละ 72 

 
ตารางท่ี  2 จ าแนกร้อยละของสภาพทั่วไปของกลุ่มตัวอย่าง จ าแนกตามอายุ 

อาย ุ/ ปี จ านวน ( คน ) ร้อยละ (%) 

15-19 25 100 

20-25 - - 

26-29 -  

30  ขึ้นไป - - 

รวม 25 100 

 
จากตารางที่ 2 พบว่าสถานภาพทั่วไปของกลุ่มตัวอย่างนักเรียน-นักศึกษา จ าแนกตาม อายุ 

จาก กลุ่มตัวอย่างทั้งสิ้น จ านวน 25 คน 

-          อายุ 17-19 จ านวน 12 คน คิดเป็นร้อยละ 48 

-          อายุ 20-25 จ านวน 13 คน คิดเป็นร้อยละ 52 

-          อายุ 26-29 จ านวน 0 คน  
-          อายุ 30 ขึ้นไป จ านวน 0 คน  
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ตารางท่ี 3 จ าแนกร้อยละของสภาพทั่วไปของกลุ่มตัวอย่าง จ าแนกตามอาชีพ 

อาชีพ จ านวน ( คน ) ร้อยละ (%) 

นักเรียน / นักศึกษา 12 48 

รับราชการ / รัฐวิสาหกิจ - - 

พนักงานบริษัทเอกชน - - 

ธุรกิจส่วนตัว / เจ้าของกิจการ - - 

รวม 25 100 

 
จากตารางที่ 3 พบว่าสถานภาพทั่วไปของกลุ่มตัวอย่างนักเรียน-นักศึกษา จ าแนกตาม อาชีพ 

จาก กลุ่มตัวอย่างทั้งสิ้น จ านวน 25 คน 

-          นักเรียน / นักศึกษา จ านวน 12 คน คิดเป็นร้อยละ 48 

-          รับราชการ/รัฐวิสาหกิจ จ านวน - คน  
-          พนักงานบริษัทเอกชน จ านวน 12 คน คิดเป็นร้อยละ 48 

-          ธุรกิจส่วนตัว / เจ้าของกิจการ 1 คน คิดเป็นร้อยละ 4 

 

ตารางท่ี 4 จ าแนกร้อยละของสภาพทั่วไปของกลุ่มตัวอย่าง จ าแนกตามทักษะทางคอมพิวเตอร์ 

ทักษะทางคอมพิวเตอร์ จ านวน ( คน ) ร้อยละ (%) 

ดีมาก 5 20 

ดี 8 32 

ปานกลาง 10 40 

ปรับปรุง 2 8 

รวม 25 100 

 
จากตารางที ่4 พบว่าสถานภาพทั่วไปของกลุ่มตัวอย่างนักเรียน-นักศึกษา จ าแนกตามทักษะ

ทางคอมพิวเตอร์ จากกลุ่มตัวอย่างทั้งสิ้น จ านวน 25 คน 

-          ดีมาก จ านวน 5 คน คิดเป็นร้อยละ 20 

-          ดี จ านวน 8 คน คิดเป็นร้อยละ 32 

-          ปานกลาง จ านวน 10 คน คิดเป็นร้อยละ 40 

-          ปรับปรุง ขึ้นไป จ านวน 2 คน คิดเป็นร้อยละ 8 
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ตอนที ่2 ผลการวิเคราะห์ค่าเฉลี่ยของการสอบถามความคิดเห็นของนักเรียน–นักศึกษา
เกี่ยวกับการน าเสนอ โดยใชโ้ปรแกรม Adobe Photoshop CS6 ของนักเรียน–นักศึกษา 
ประกาศนียบัตรวิชาชีพชั้นปีที่ 2 ภาคพิเศษ วิทยาลัยเทคโนโลยีอักษรบริหารธุรกิจ  ผู้ศึกษาจัดท า
โครงงาน ได้น าเสนอดังนี้ 

 
      ตารางท่ี 5 ตารางสรุปแบบประเมินความพึงพอใจสื่อการเรียนรู้เรื่องการใช้โปรแกรม 
Adobe Photoshop CS6 

รายการการประเมินผล ค่าเฉลี่ย 
 

ระดับความพึง
พอใจ 

1.ความส าคัญของโครงการ 4.4 มาก 

2.เนื้อหาความสอดคล้องเหมาะสม 4 มาก 

3.วิธีการด าเนินงานและผลที่ได้รับ 4 มาก 

4.ความคิดริเริ่ม สร้างสรรค์ 4.65 มากที่สุด 

5.การน าไปใช้ประโยชน์ได้อย่างคุ้มค่า 4.3 มาก 

ค่าเฉลี่ยรวม 4.27 มาก 

 

*เกณฑ์การวัดระดับความพึงพอใจ 

4.51 - 5.00 มากที่สุด 
3.51 - 4.50 มาก 
2.51 - 3.50 ปานกลาง 
1.50 - 2.50 น้อย 
1.00 - 1.50 น้อยที่สุด 
การประเมินส่วนใหญ่มีการประเมินการสร้างสื่อการเรียนรู้ เรื่อง การน าเสนอโดยใช้โปรแกรม 

Adobe Photoshop CS6 โดยภาพรวมอยู่ในระดับมาก มีค่าเฉลี่ย  4.27 และเม่ือพิจารณารายข้อ

พบว่าผู้ประเมินมีความพึงพอใจในเรียงตามล าดับดังนี้ 
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ล าดับที่ 1 ความคิดริเริ่มสร้างสรรค์ มีผลประเมินความพึงพอใจอยู่ในระดับ มากที่สุด มี
ค่าเฉลี่ย 4.65 

ล าดับที่ 2 ความส าคัญของโครงการ มีผลประเมินความพึงพอใจอยู่ในระดับ มาก มีค่าเฉลี่ย 
4.4 

ล าดับที่ 3 การน าไปใช้ประโยชน์ได้อย่างคุ้มค่า มีผลประเมินความพึงพอใจอยู่ในระดับ มาก 
มีค่าเฉลี่ย 4.3 

ล าดับที่ 4 วิธีการด าเนินงานและผลที่ได้รับ มีผลประเมินความพึงพอใจอยู่ในระดับ มาก มี
ค่าเฉลี่ย  4 

ล าดับที่ 5 เนื้อหาและความสอดคล้องของโครงการ มีผลประเมินความพึงพอใจอยู่ในระดับ 
มาก มีค่าเฉลี่ย  4 
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บทที่ 5 

สรุป อภิปราย และข้อเสนอแนะ 
 

โครงการสร้างสื่อการเรียนรู้ เรื่อง การออกแบบป้ายโฆษณาโดยใช้โปรแกรม Adobe 

Photoshop CS6  มีผลสรุป อภิปราย และข้อเสนอแนะเรียงตามล าดับดังนี้  

สรุปผล 

1. สามารถใช้โปรแกรม Adobe Photoshop CS6 ในพัฒนาและสร้างสื่อการเรียนการสอน 
ในชั้นเรียนและสื่อการเรียนรู้ในการศึกษาด้วยตนเองได ้ 

2. ความพึงพอใจของผู้ใช้สื่อการเรียนรู้โปรแกรม Adobe Photoshop CS6 ในการตกแต่ง
ท าป้ายโฆษณา นักเรียนมีความพึงพอใจต่อสื่อการเรียนรู้ที่ระดับ 4.27 คือ พอใจมาก 
 

อภิปรายผล 

  จากการศึกษาการใช้โปรแกรม Adobe Photoshop CS6สร้างสื่อการเรียนรู้มีประเด็นที่

น ามาอภิปรายผล ได้ดังนี้  

1. สื่อการเรียนรู้ เรื่อง การใช้โปรแกรม Adobe Photoshop CS6 ในการน าเสนอ  
เป็นการน าความรู้ความสามารถจากการเรียนในสาขาวิชาคอมพิวเตอร์ ศึกษาค้นคว้าเพ่ิมเติมจาก
แหล่งเรียนรู้ทางอินเตอร์เน็ตโดยใช้โปรแกรม Adobe Photoshop CS6 มาสร้างสื่อการเรียนการ
สอนในชั้นเรียน และสื่อการเรียนรู้ในการศึกษาด้วยตนเอง ซึ่งสามารถน ามาใช้ได้จริงในการเรียนการ
สอนในสาขาวิชาคอมพิวเตอร์ 
 

2. ความพึงพอใจของผู้ใช้สื่อการเรียนรู้โปรแกรม Adobe 
Photoshop CS6 ในการน าเสนอ นักเรียนมีความพึงพอใจต่อการตกแต่งท าป้ายโฆษณาที่ระดับพอใจ
มาก  คือ ระดับ 5 ทั้งนี้อาจเป็นเพราะสื่อการเรียนรู้ มีภาพการตกแต่งและสีสันที่ดึงดูดตา จนเกิด
ทักษะการเรียนรู้ที่ดี ท าให้นักเรียนมีความพึงพอใจ รู้สึกประทับใจในการตกแต่งป้ายโฆษณาท่ีสวยงาม 
แปลกใหม่กว่าแบบเดิมๆ และสามารถน าไปปฏิบัติด้วยตนเองได้ 
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ปัญหาและอุปสรรค 

 1. ไม่มีการจัดสรรเวลาด าเนินงานที่ดี ท าให้บางช่วงของการด าเนินงานเกิดปัญหาและไม่

สามารถส่งความคืบหน้าของโครงการได้ทันเวลา 

 2. เนื้อหาของตัวโปรแกรมมีน้อย ต้องศึกษาค้นคว้าจากแหล่งการเรียนรู้อ่ืนร่วมด้วย เช่น 

หนังสือเฉพาะของโปรแกรม คู่มือการใช้งาน (โปรแกรมลิขสิทธิ์) เป็นต้น 

 3. สมาชิกในกลุ่มควรให้ความร่วมมือกัน เอาใจใส่และให้ความส าคัญของการด าเนินงานให้

มากกว่านี้ ประชุมหรือปรึกษาหารือกัน แก้ปัญหาร่วมกัน เพื่อประสิทธิภาพในการท างานร่วมกัน 

 4. ควรปรึกษาอาจารย์ที่มีความรอบรู้ในด้านเนื้อหาและโปรแกรมคอมพิวเตอร์ เพ่ือความ

รวดเร็วในการเรียนรู้ มากกว่าที่จะเรียนรู้ด้วยตนเองทั้งหมด 

 

ข้อเสนอแนะหรือแนวทางในการแก้ไขปัญหา 

 1.ในระหว่างที่ท าการตกแต่งป้ายโฆษณาโดยใช้โปรแกรม Adobe Photoshop CS6 นั้นควร

ท าแล้วก็กดเซฟงานบ่อยๆ เพราะบางครั้งอาจเกิดเหตุขัดข้องในการใช้โปรแกรมได้ เช่น คอมพิวเตอร์

ของท่านอาจจะดับระหว่างท างานอยู่ หรืออาจเกิดจากการที่โปรแกรมไม่ตอบสนองหรือค้างนั่นเอง 

เพราะฉะนั้นเราจึงควรท าการเซฟชิ้นงานที่ท าอยู่บ่อยๆ เพ่ือที่จะได้ไม่ต้องมาเสียเวลาในการเริ่มท า

ชิ้นงานใหม่ทั้งหมด   

2. รายงานโครงการ 5 บท ควรให้ความส าคัญกับการจัดรูปแบบให้ถูกต้อง สวยงาม ตาม
รูปแบบหรือโครงสร้างที่ก าหนดให้ 
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เอกสารอ้างอิง 

Salinee chot.(2016), Doctor Strange Poster สอนแต่งภาพโปสเตอร์ สอนโฟโต้ชอปออนไลน์ 

Photo manipulation [ EP. 14 ] (ออนไลน์), เข้าถึงได้จาก : 

https://www.youtube.com/watch?v=Sex2SgYkfMA  

(วันที่สืบค้นข้อมูล 13 กันยายน 2560) 

Ven Do.(2016),วิธีการออกแบบป้ายไวนิลด้วย Adobe Photoshop CS6 (ออนไลน์),  

เข้าถึงได้จาก : https://www.youtube.com/watch?v=OlH_Tzkimbo 

(วันที่สืบค้นข้อมูล 14 กันยายน 2560) 

Jame_atthaphon Channel.(2016), เทคนิคแต่งภาพหน้าร้าน หรือป้ายโฆษณา ด้วย Photoshop 

CS6 (ออนไลน์), เข้าถึงได้จาก : 

https://www.youtube.com/watch?v=Lwa1o27KGV8 

(วันที่สืบค้นข้อมูล 14 กันยายน 2560) 

 

 

 

 

 

 

 

 

 

 

https://www.youtube.com/channel/UCLnWVIuLHIr973x23ofj9vQ
https://www.youtube.com/watch?v=Sex2SgYkfMA
https://www.youtube.com/watch?v=OlH_Tzkimbo
https://www.youtube.com/watch?v=Lwa1o27KGV8
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ประวัติผู้จัดท าโครงการ 

 
 
 
 
 
 
 
 
ชื่อ-นามสกุล  นางสาวสิริวรรณ  พึ่งขุนทด 
ชื่อเล่น   บี ่
วัน เดือน ปีเกิด  17 กุมภาพันธ์ 2540 
ที่อยู่ปัจจุบัน  20/8 ถ.ตากวน-อ่าวประดู่ ต.มาบตาพุด อ.เมือง จ.ระยอง  
เบอร์โทรศัพท์  091-4548413 
สถานศึกษาเดิม  โรงเรียนมาบตาพุดพันพิทยาคาร 
ก าลังศึกษาอยู่ที่  วิทยาลัยเทคโนโลยีอักษรบริหารธุรกิจ 
ความสามารถพิเศษ - 
อีเมล์   noobea40@gmail.com          
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ประวัติผู้จัดท าโครงการ 

 
 
 
 
 
 
 
 
ชื่อ-นามสกุล  นางสาวน้ าผึ้ง  แป้นขุนทด 
ชื่อเล่น   เล็ก 
วัน เดือน ปีเกิด  5 สิงหาคม 2540 
ที่อยู่ปัจจุบัน  14/172 ต.เนินพระ อ.เมือง จ.ระยอง  
เบอร์โทรศัพท์  088-1962631 
สถานศึกษาเดิม  โรงเรียนมาบตาพุดพันพิทยาคาร 
ก าลังศึกษาอยู่ที่  วิทยาลัยเทคโนโลยีอักษรบริหารธุรกิจ 
ความสามารถพิเศษ - 
อีเมล์   leklekza2540@gmail.com  
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ประวัติผู้จัดท าโครงการ 

 
 
 
 
 
 
 
 
ชื่อ-นามสกุล  นางสาวอภิชญา  สรเดช 
ชื่อเล่น   อุ้ม 
วัน เดือน ปีเกิด  14 กุมภาพันธ์ 2541 
ที่อยู่ปัจจุบัน   6/11 ซอยแม่เจือ ถนนทางหลวงระยอง3191 ต.มาบตาพุด อ.เมือง  

 จ.ระยอง 
เบอร์โทรศัพท์  089-4056959 
สถานศึกษาเดิม  โรงเรียนมาบตาพุดพันพิทยาคาร 
ก าลังศึกษาอยู่ที่  วิทยาลัยเทคโนโลยีอักษรบริหารธุรกิจ 
ความสามารถพิเศษ - 
อีเมล์    nuoomza_za@hotmail.com 
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ประวัติผู้จัดท าโครงการ 

 
 
 
 
 
 
 
 
ชื่อ-นามสกุล  นางสาวเกตน์สิรี  เต่าบุบผา 
ชื่อเล่น   เกต 
วัน เดือน ปีเกิด  2 กรกฎาคม 2540 
ที่อยู่ปัจจุบัน  12/14 มาบตาพุด ซ.12 ต.มาบตาพุด อ.เมือง จ.ระยอง  
เบอร์โทรศัพท์  062-3214103 
สถานศึกษาเดิม  โรงเรียนมาบตาพุดพันพิทยาคาร 
ก าลังศึกษาอยู่ที่  วิทยาลัยเทคโนโลยีอักษรบริหารธุรกิจ 
ความสามารถพิเศษ - 
อีเมล์   ketsiri02072540@gmail.com  
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ประวัติผู้จัดท าโครงการ 

 
 

 
 
 
 
 
 
ชื่อ-นามสกุล  นางสาวอนงค์นาฏ  วงค์อุปปะ 
ชื่อเล่น   จ๋า 
วัน เดือน ปีเกิด  15 มีนาคม 2541 
ที่อยู่ปัจจุบัน  1/1 ซอยประปา1 ต.เนินพระ อ.เมือง จ.ระยอง 
เบอร์โทรศัพท์  092-8482216 
สถานศึกษาเดิม  โรงเรียนนาด้วงวิทยา 
ก าลังศึกษาอยู่ที่  วิทยาลัยเทคโนโลยีอักษรบริหารธุรกิจ 
ความสามารถพิเศษ - 
อีเมล์   Anongnat771@gmail.com  

 
 

 

 

 

 


